
RuG LaTEX Course 2012

Figures in LaTEX

Contents
1 Introduction 1

2 The macros 1
2.1 Optional parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
2.2 Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

3 Types of graphics 2
3.1 More about bitmaps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
3.2 Bitmap resolutions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
3.3 More about vector graphics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
3.4 Proprietary formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

4 Creating graphics 6
4.1 Drawings and diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
4.2 Draw programs with LaTEX support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.3 Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
4.4 Bitmaps: paint programs and image editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
4.5 Screenshots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

5 Converting to compatible formats 9
5.1 Converting bitmaps to png, jpg and eps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
5.2 Converting between PostScript, eps and pdf . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
5.3 Exporting eps and PostScript from Windows programs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

URLs 11

1 Introduction

This guide describes how to use external graphics in your LaTEX document. Section 2 covers the
macros that you need. The remainder of the guide is about the graphics themselves, and how to
get them into LaTEX: section 3 discusses types of graphics, with examples; section 4 lists some
programs and methods for creating and editing graphics, and section 5 explains how to convert
them into formats that LaTEX can handle.

This guide does not go into creating graphics with LaTEX macros. You can read about it in The
Not So Short Introduction, chapter 5 and the documentation of the respective packages.

2 The macros

Graphics inclusion is not built into the LaTEX core. You need to load a package which provides
this facility1:

1. The examples here use the graphicx package. For very old documents which use epsf or psfig you can load
the epsfig package instead. It supports the same syntax but makes use of the modern implementation of graphics
inclusion. There should be no reason to keep using the old epsf or psfig packages.
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2 FIGURES IN LATEX

\usepackage{graphicx}
...
\includegraphics{mouse}

or, if you want to put the graphic inside a figure environment:

\usepackage{graphicx}
...
\begin{figure}[h]
\centering
\includegraphics{blocks}
\caption{Example figure environment}%

\label{figenv}
\end{figure}
See Figure~\ref{figenv}.

Figure 1: Example figure environment

See Figure 1.

You can read more about the figure- and other floating environments in Oetiker et al., 2011
Section 2.12.

2.1 Optional parameters

You can scale and rotate your graphics with optional parameters:

\includegraphics[height=...,angle=...,...]{figure file}

The examples below illustrate scaling to a specified height or width, scaling by a factor and
rotating:

[width=1in] [height=.7in] [angle=45,scale=.5]

2.2 Tips

» If you want to resize your graphic to text width, use [width=\linewidth]. \linewidth
is the current text width. It takes e.g. column typesetting and indenting within lists into
account.

» Most of the time, you can omit the extension, e.g. .eps or .pdf: LaTEX and pdflatex automati-
cally pick file types they can handle; more about this in section 5 about file formats for LaTEX
and pdflatex.

» Don’t use an absolute path such as c:/course/graphics/figure. Absolute paths make
it hard to move your documents to another location or another system. You can put your
graphics in the same directory as your LaTEX source and then just use the filename, or you
can put them in a subdirectory and use a relative path such as graphics/figure.

» Don’t use the TeXnicCenter Insert Picture... menu item. This generates absolute paths and
explicit extensions. In contrast, TeXstudio handles this in a sane way.

3 Types of graphics

Graphics can be defined in different ways, depending on the type of information they contain
and on the software with which they have been created. Figures 1–3 contain some examples,
each together with an enlarged details.
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3 Types of graphics 3

Figure 1. Bitmapped- or raster graphics: above a photograph, below a screenshot, both
with an enlarged detail at the right

A bitmap or raster graphic is built up as a grid of pixels. Figure 1 shows a photograph and a
screenshot. The pixels are obvious in the enlarged detail.

Vector graphics are defined in terms of lines, circles, curves and other geometric shapes. They
do not pixelate at any scale; see figure 2.

Some file formats can contain both raster and vector data. In figure 3, the raster background
becomes blocky when enlarged, but the text on top remains sharp.

3.1 More about bitmaps

Bitmapped file types. Common file extensions for bitmaps or raster images include .bmp, .gif,
.jpg, .pbm, .png, .tif and .xpm. These file types are intended for exchange, i.e. they are not tied
to any particular program.

Compression types. High-resolution bitmapped files can get very large. There are various
ways to reduce those file sizes.

Lossless compression works by storing information in a more compact way. A very simplified
example: instead of enumerating a thousand identical white pixels one by one, you can say at
once that the next one thousand pixels are white. Lossless compression can be quite effective
when there are large areas of solid colors or regular patterns. Png is a lossless bitmapped format
that can be processed directly by pdflatex.

Lossless compression doesn’t work so well with photographic images. When we no longer insist
on exactly preserving every bit of information and accept lossy compression, then very good
results can be reached with jpeg. At medium to high quality settings, the loss of information is
essentially invisible, but the compression rate is easily 10:1. When you save in jpeg format you
can usually make your own tradeoff between file size and image quality.
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Figure 2. Vector art: a LibreOffice data plot, a drawing adapted from a Ghostscript
example file and a graphic generated with MetaPost

For non-photographic bitmapped images such as screenshots or logos, jpeg compression pro-
duces visible artifacts; see figure 4. To be fair, for the right image quality was set very low in
order to make the artifacts more obvious. Here, compression isn’t all that good either compared
to png. Nevertheless, many people use jpeg compression indiscriminately, even when png would
have been much better.

For the record: of the above-mentioned raster image formats, .bmp, .pbm and .xpm are uncom-
pressed, .gif and .png have lossless compression, .jpg lossy compression, and .tif may have any
type of compression, or none at all.

Although .gif is compressed in a lossless way, it cannot contain full-color images, only images
with a palette of up to 256 colors. For photographic images, this color reduction can do much
more damage to the end result than lossy compression.

3.2 Bitmap resolutions

The resolution of a bitmap should be high enough to look sharp, but, in order to keep file size
and loading times within bounds, the resolution should not be higher than necessary.

For screen viewing, the ideal resolution would be exactly one bitmap pixel per screen pixel, but
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The End
01/04/07 6

The End
01/04/07 6

Figure 3. Raster and vector combined

Figure 4. Don’t use jpeg compression for screenshots.

of course you may not know at what screen resolution and zoom level your document will be
viewed.

For printing, good resolutions are:

Photographs. 150–300 DPI (dots per inch) depending on the output device. Most printers
and imagesetters simulate grays and other tints with dot patterns or halftone screens. As a
consequence, the effective printed resolution of a photograph is much lower than the resolution
of the output device, no matter how high the resolution of the original photograph.

Charts and diagrams. 600–1200 DPI. 600 is enough to avoid visible blockiness. Higher reso-
lutions can mean finer detail, if the printer resolution is also high. But vector formats are better
for such graphics.

Screenshots. Keep the original resolution.

Of course I am talking about resolution after scaling; if you print a 5 cm wide, 300 DPI image
at a width of 10 cm then the effective resolution is 150 DPI.

It will do no good to increase the resolution of an existing low-resolution image; it might even
make the output fuzzier. So either try to get a better original, or use your bad picture as-is.

3.3 More about vector graphics

Eps and pdf. The two vector formats that matter here are eps (Encapsulated PostScript) and
pdf. Pdf is an offshoot of PostScript. There are many similarities between the two formats,
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6 FIGURES IN LATEX

and it is often possible to convert a file from one format to the other and back again without
real loss of information; see section 5.2. Svg is another related format, but is currently not
well-supported by TEX.

These formats can contain vector objects, text and also bitmaps, all in the same file; see e.g.
figure 3.

Problems with vector graphics.

Missing fonts. If some standard fonts (Times, Helvetica, Courier, Symbol, Zapf Dingbat) are
not embedded then epspdftk (see section 5.2) can help. If the pdf output target is set to prepress
then fonts will be embedded during conversion to pdf. Epspdftk can convert back and forth
between eps and PostScript on the one hand and pdf on the other. You can either apply a pdf-to-
eps-to-pdf conversion to individual graphics or a pdf-to-ps-to-pdf conversion to the document
as a whole. With the upcoming version 0.6, direct conversion from pdf to pdf might also work.

If other fonts are missing then you have a real problem.

Zero-width lines. If your graphic has some very thin lines, then check by zooming in whether
the lines have some positive width. A line width of zero will be interpreted by the output device
as a width of one pixel, which is fine for the screen or for an old 300 DPI laserprinter, but not
for a 2400 DPI imagesetter. A line width of e.g. 0.3pt should be safe. You may be able to fix this
from within the program with which the graphic was created.

Transparency and fill patterns. Many programs and graphic formats do not support transparancy
or fill patterns; upon conversion these features might either get lost altogether or simulated with
e.g. bitmaps, which might make the file much larger and virtually uneditable. Hang on to the
original – which you should do in any case.

General fixes. You may be able to import the file in a draw program and fix problems there:
substituting fonts, changing line widths, replacing pattern fills with something else; see section 4
on draw programs.

If the amount of text is small, e.g. just a logo, consider converting the text to curves, i.e. charac-
ters are replaced by their shapes, losing the reference to the font.

As a last resort, you can convert your graphic to a bitmapped png file of sufficiently high resolu-
tion.

3.4 Proprietary formats

Graphics editors can also have their own native format, e.g. .psd for PhotoShop, .cdr for Corel-
Draw or .xcf for the Gimp. These formats support additional structure, which makes them better
for editing, at least with the original graphics editor. Even if you save in a LaTEX-compatible for-
mat, you may want to preserve the native version as well for future editing. This is especially
true for vector graphics.

Another trend is to store private information for future editing in a hidden stream in the ex-
ported file. The svg, eps and pdf formats can contain such hidden streams, and various pro-
grams use that fact. This private information may not be readable by another graphics editor,
but a program such as LaTEX that only needs to render the file can simply ignore it.

4 Creating graphics

In computer graphics, the term drawing means making vector pictures and painting means
making bitmapped pictures.
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4 Creating graphics 7

Figure 5. Inkscape, a free vector draw program for Linux, Windows and Mac OS X

You should be able to use any eps, pdf or bitmapped graphic with LaTEX and derivatives2, al-
though sometimes conversion may be needed. See section 5 for details. The only real concern
is getting vector graphics intact into eps- or pdf format.

4.1 Drawings and diagrams

You can create drawings and diagrams in Word or PowerPoint. MS Office version 2010 has a
nice pdf export option (Save as pdf; click on Options to specify what you actually want to export,
e.g. the current selection). But do not forget to check out some free alternatives. Inkscape is
a specialized draw program resembling CorelDRAW and Illustrator. It uses svg as its native
format and can export to pdf. Or try the Draw module of LibreOffice/OpenOffice.org. This MS
Office alternative is fairly good at reading and writing MS Office files, and also has a pdf export
option.

If you spend a lot of time creating and editing vector graphics, and especially if you also need to
ready your documents for professional printing, consider buying a professional draw program
such as CorelDRAW or Illustrator, part of Adobe’s Creative Suite.

Under Mac OS X there are several inexpensive commercial programs worth checking out. Since
OS X supports pdf natively, getting a good pdf from your graphic is rarely a problem, even from
cheap or office-centric graphics programs.

In any case, investigate at an early stage how to get your drawings into LaTEX, see section 5.

October 6, 2012



8 FIGURES IN LATEX

ℵ
Regular text

Figure 6. Text and math as shown by TpX and as rendered by the parent document

Figure 7. Entering a LaTEX equation in Inkscape

4.2 Draw programs with LaTEX support

LaTEX-oriented draw programs include Ipe (cross-platform) and TpX (Windows-only). TpX is
also available from CTAN. Both are free.

Ipe renders text and formulas itself, using LaTEX. You can tune the output via preamble com-
mands (Edit > Document properties).

TpX normally leaves the rendering of text and math to the parent document: when saving, it
creates three files: an eps- and a pdf file with everything which is not text or math, and a LaTEX
file with extension .tpx which typesets text and math and loads either the eps or the pdf. This
TpX file has to be \input-ed into the parent document.

This way, text and math in the drawing are automatically in step with the document; see fig-
ure 6.

TpX has additional export options; see its documentation.

CTAN and Sourceforge (http://sourceforge.net/directory/development/data-formats/
tex-latex/) contain several other such programs.

LaTEX support in Inkscape. Inkscape, already mentioned in section 4.1, also offers some forms
of LaTEX support:

» If Inkscape finds LaTEX and some auxiliary programs (Ghostscript, pstoedit), it may offer
support for LaTEX objects: Extensions > Render > LaTEX formula; see figure 7.

» If you want editable LaTEX objects, you can try whether the textext extension (url http:
//pav.iki.fi/software/textext/, menu item Extensions > Tex Text) works for you.

» If you save an Inkscape drawing to pdf, one of the export options is ‘PDF+LaTeX: Omit text
in PDF, and create LaTeX file’. This appears to apply only to regular text.

4.3 Charts

Charts are normally generated as a byproduct of spreadsheets or mathematical software. Mathe-
matical and statistical programs often have eps- or pdf export options, and sometimes also have

2. To be precise, the term ‘derivative’ applies to the underlying TEX engine (pdftex, xetex, luatex), not to the LaTEX
macro package on top of it.
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5 Converting to compatible formats 9

Figure 8. Bitmap2eps, a right-click item to convert a bitmap to eps format

support for LaTEX text labels. As to spreadsheets, see section 4.1.

4.4 Bitmaps: paint programs and image editors

There exists a large selection of free and inexpensive paint programs and image editors. As
to pre-installed programs: Windows already includes Paint, a very basic bitmap editor, which,
however, can read and write a variety of formats, and can also crop images. Mac OS X includes
Preview. Besides reading pdf documents, this program can also read, convert and crop3 images.

4.5 Screenshots

You can take screenshots without specialized software:

Windows. The PrtScrn key will copy the entire screen to the clipboard, and Alt-PrtScrn the
active window. Most paint- and image-editing programs can retrieve the screenshot from the
clipboard, usually with Edit / Paste. They also have tools to crop images.

Mac OS X. Cmd-Shift-3 copies the entire screen to a file on your desktop, and Cmd-Shift-4 lets
you make a selection.

Linux. Here, depending on your chosen desktop and configuration, PrtScrn will probably take
a screenshot as well, either to the clipboard or to a file. I usually take screenshots with the Gimp
(File > Acquire > Screenshot).

5 Converting to compatible formats

The LaTEX derivatives pdflatex, xelatex and lualatex all can use the bitmapped formats png and
jpeg directly as graphics formats.

For vector graphics, you can use either pdf or eps, although eps requires a conversion4, and this
may have been disabled for security reasons. If on-the-fly conversion is not available, you can
still convert in a separate step; see section 5.2.

For the LaTEX plus dvips route, you are restricted to eps format. If at all possible, use one of the
LaTEX alternatives.

5.1 Converting bitmaps to png, jpg and eps

Almost any image editor and paint program can convert to png and jpg. This is all you need
unless you have to use LaTEX itself and need eps format. More advanced programs can export
to eps (and to pdf).

For Windows Explorer, TEX Live 2011 and later add a right-click menu item bitmap2eps to

3. Indirectly, via ‘New from clipboard’
4. In the case of pdflatex and lualatex, the eps is converted to a file filename -eps-converted-to.pdf, in the case
of xelatex the converted code is written directly to the pdf output of the document without creation of an intermediate
file.
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bitmapped formats for conversion to eps; see figure 8. It makes use of the command-line
converter sam2p, with bmeps as a fallback. MikTeX users can run bmeps from the command-
line.

On Unix-based systems the obvious choice for a command-line converter is convert:

convert filename.png filename.eps

Convert is packaged for most Linux distributions as part of ImageMagick. Convert itself is in-
cluded in MacTEX.

5.2 Converting between PostScript, eps and pdf

epstopdf. Epstopdf is the program used for on-the-fly conversion from eps to pdf. It is part of
most TEX distributions and is probably already on your system. Epstopdf uses Ghostscript, either
a standalone version or the version built into the TEX distribution.

Epspdf and epspdftk. Epspdf can convert back and forth between PostScript, eps and pdf, in
many cases with no loss of information. It can also remove unwanted borders (compute tight
boundingbox option) and convert some color graphics to grayscale. It uses Ghostscript and
optionally pdftops from the xpdf suite.

Epspdftk is a GUI program, using epspdf in the background.

A LaTEX package epspdfconversion substitutes epspdf for epstopdf for on-the-fly conversion to
pdf. Note that it needs shell-escape to be fully enabled; see the package documentation.

Convert. On many systems, convert from the ImageMagick suite will use Ghostscript when
converting between eps and pdf, and will in that case convert vector graphics to vector graphics.
Prefix the target pdf filename with EPDF: if you want to preserve the eps boundingbox. View
the result at a high zoom level to make sure that it is indeed still a vector graphic.

Ghostscript and pdftops. You can also use Ghostscript directly for converting eps and PostScript
to pdf, and either Ghostscript or pdftops from the Xpdf suite for converting in the other direc-
tion. Ghostscript includes various scripts/batchfiles to facilitate these conversions. But this is
not the place for explaining the use of these programs.

Pdfcrop. This command-line utility is not exactly a converter, but it removes empty margins
from each page in a pdf file, using pdftex and Ghostscript-generated boundingboxes. Included
in both MiKTEX and TEX Live.

5.3 Exporting eps and PostScript from Windows programs

If a Windows program does not have a usable export option, then you can try to ‘print’ to a
PostScript file.

For this, you need to have a PostScript printer driver. If you don’t have one installed, go to
‘Printers’ and start up the Add Printer wizard. Choose Local Printer and uncheck automatic
detection. As printer port, you can pick FILE, otherwise you would have to manually check
‘Print to File’ anytime you print. A good choice for manufacturer and model would be ‘Generic’
and ‘MS Publisher Imagesetter’ respectively.

Pay attention to printer settings: in the Print dialog, click ‘Properties’, then ‘Advanced’ (on either
tab). In the ‘Advanced Document Settings’ tree, under ‘Graphic’, ‘TrueType Font’ should be set
to ‘Download as Softfont’5

Now navigate to first ‘Document Options’, then ‘PostScript Options’. For ‘PostScript Output
Option’ the default setting is ‘Optimize for speed’. Change that to ‘Optimize for Portability’ or

5. The alternative setting is ‘Substitute with Device Font’. For prepress use, you should always include all fonts. It is
possible to include fonts after the fact, when converting to pdf, but then you run the risk of noticeable discrepancies
between the original font and the actually included font.
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Figure 9. configuring a PostScript printer driver

‘Archive Format’, or, for single pages only, ‘Encapsulated PostScript’. These non-default options
presumably produce cleaner PostScript code, without printer-specific hacks. Experiment with
this and other options if you run into problems (e.g. bad-looking screen output, or part of a
graphic getting cut off, or conversion to bitmap).

Next, the setting ‘TrueType Font Downloading Option’ should be set to ‘Outline’, not ‘Automatic’
or ‘Bitmap’.

URLs

CTAN. The Comprehensive TEX Archive Network. URL: http://mirror.ctan.org/.

Epspdf and epspdftk. Available from CTAN. URL: http://tex.aanhet.net/epspdf/.

Ghostscript. Free PostScript interpreter. URL: http://ghostscript.com/.

ImageMagick. For converting and manipulating images. URL: http://imagemagick.org/.

Inkscape. Draw program. URL: http://inkscape.org/.

Ipe. Draw program with LaTEX support. URL: http://sourceforge.net/projects/ipe7/.

LibreOffice. Office suite. URL: http://www.libreoffice.org/.

MacTEX. TEX Live for Mac OS. URL: http://www.tug.org/mactex/.

Oetiker, Tobias et al. (2011). The Not So Short Introduction to LaTEX2ε. Included in most free TEX
distributions. URL: http://mirror.ctan.org/info/lshort/.

TpX. Draw program with LaTEX support; available from CTAN. URL: http://sourceforge.
net/projects/tpx/.

Xpdf. Pdf viewer and utilities. URL: http://www.foolabs.com/xpdf/.
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